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IntelligenceConnect allows providers/submitters to access reports and data sets directly from the
Collaborative’s system through our website. This feature does not require special software.

An upgrade to IntelligenceConnect was implemented in late September, 2013. This upgrade
includes changes to the interface, its usage and improved performance.

If you have questions or need technical guidance regarding the reports that are available on
IntelligenceConnect, contact the e-Support Helpdesk at (888) 247-9311. You may also email the
helpdesk directly at e-supportservices@valueoptions.com.

Questions that are out of the scope for the e-Support Helpdesk will be forwarded to the
Collaborative reporting staff for resolution.
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Accessing IntelligenceConnect

1. Access http://www.illinoismentalhealthcollaborative.com and click on the For Providers
link. This will display the Provider Online Services Home Page.

2. Click on Log In, which displays the ProviderConnect Log In page. Enter your User ID
(Submitter ID) and password and click on Log In button.

3. After logging in, select “l Agree” at the User Agreement screen and before proceeding
you will need to acknowledge the Message from webpage box by clicking “OK” after
reading.

4. The Welcome page now displays with the related menu options displayed on the left side
of the screen.

5. Torun areport, click on the “Reports” button on the left.
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IntelligenceConnect Home Page

Once you click on “Reports” in ProviderConnect, the IntelligenceConnect home page displays.

S INTELL |L| EUN-\'ECT \Welcome: Masiliunas, Cheryl | applications ™ Help Menu = Log Off ye
Home | Documents
A
* My Recently Viewed Documents * 18 Unread Messages in My Inbox ~ My Applications I
IEIL Online Expiring Consumer Reg.. é—JIL DMH Consumer Registration ...
@IL Cnline Expiring Consumer Reg... @IL Online Expiring Consumer Reg.. \)
¥FPhase 1 -HFS Claims Dashboarc. .. EIL Online Expiring Consumer Reg...
©#| DB phase II to check IEIL Online Expiring Consumer Reg..
IEIL Online Expiring Consumer Reg.. ‘:“:‘
EIL Online Expiring Consumer Rec... \i”_‘
IEIL Report of Denied Claim Lines ...
IEIL Online Expiring Consumer Re..
0 Repart of EDI-337P Batch Cl... \9
é—JIL DMH Consumer Registration ...
See More...
~ My Recently Run Documents * 0 Unread Alerts
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The Home Tab allows for quick access to reports and information that you use on a regular basis.
There are two main tabs located in the upper left-hand corner: Home and Documents.

J Home | Documents

The Home tab displays the four main areas of interaction within IntelligenceConnect.

e The My Recently Viewed Documents portion displays the recent documents that you
have used so that you will not have to search for items that you have recently accessed.

e Any messages programmed within reports when they run will be seen in My Inbox.

e The My Recently Run Documents section displays all the reports you have recently run.

e Any preprogrammed alerts within a scheduled report or from the business objects
administrator display in the Alerts section.

The Documents tab is where you navigate through the content that is included in
IntelligenceConnect. This content is separated into four sections on the left-hand side. To
access the content within each of these sections, click on the names:

e My Documents

e Folders

e Categories

e Search
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The default section is My Documents which contains all of your personal documents, reports,

messages, and alerts.

~/INTELL b E?‘:E_[FUNNEU Welcome: Masiliunas, Cheryl | Applications ¥ Help Menu™ | Log OFf |

F]

Home |: Docum entsé

View ¥ MNew + Organize Send More Actions Details = M4 ofi + M
I‘.~'1y Documents Title = Type
BT My Favorites [E1 | ~Webinteligence Folder
e [} ~iWebintelligence [T | ~ebinteligence - Copy (1) Folder
..... B Webinteligence - Copy (1) 1Y 10.4 - Internal Auth Scrub Report - Weekly.rpt Crystal Reparts
£y 20.A - Ilinois HFS TAT w-dollars.rpt Crystal Reports
E nbox
IE’_,E & 20.E - F¥ 2009 - Contract Biling Report - ABC Amounts.rpt Crystal Reports
My Alerts
VA 5] | 20.E - FY2011 Weekly MCD Contract Billing.rpt Crystsl Reports
lﬁ Subscribed Alerts 2| |49410 - Weekly Pended Review Detail.rpt Crystal Reports
- @@ Personal Categories | | 66904 - Daily ICG Letter Tracking Report Crystal Reparts
. 4| |ICG_Claims_Run_Report.rpt Crystal Reports

Folders
Categories
Search < | 2
The Folders section contains all of the report folders to which you have access. This is where
ou will access and schedule your reports.
\?r'--\:T[lLH_iF-‘-:E:[EDN-\'EU \Welcome: Masiliunas, Cheryl | Applications ™ Help Menu = Log Off | |p
Home | Documents
View + Mew Crganize Send More Actions Details e LI | ofi B M
My Documents Title » Type Last Run Instances
oo [E] | AUDIT REPORTS Falder
Rl Pubic Folders] [ |cLams Folder
[ED | cLnicaL REPORTING Folder
1 |crm Folder
[ | FINANCE DEPARTMENT Folder
[EJ | 1L PROVIDER COMNECT Folder
[ | iLLmuors servIcE cenTER Folder
[ | KANSAS SERVICE CENTER Folder
{[E] | MBHP SERVICE CENTER Folder
Categories
Search
Total: 9 items
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The Categories section displays any reports or documents that have been structured for a specific
access to reports and documents in a certain area of business or category.

N/ INTLLLIGENCECONNECT

Home | Documents

Welcome: Masiliunas, Cheryl

Applications ™ Help Menu ™

Log Off
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My Documents
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f Categories

Search

Details

Title «

Type

i}

4|1 [oft » M

Total: 0 items

Utilize the Search section to find a report or document in the available folders. The names of
reports as well as the report descriptions are searchable.
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Log Off

My Documents
Folders
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When you select a report or document in any of the sections, the action bar appears at the top of
the screen.

S IMTELLIGENCECOMNECT
| Home " DQ-CIII‘I'IEI'I‘IEI
View = DMew Organize - Send More Actons - Dietails

The Action bar allows you to:
e View your latest instance or the properties used to run the report
e Create a Shortcut in My Favorites using the Organize option
e Schedule a report using the More Actions option

These actions are also available when you right-click on an object within IntelligenceConnect.
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Scheduling Reports

Navigate to the Documents tab and expand the Folders section.

"J'--\'T[LL|[_EFSE:[EUN-\' ECT Welcome: Masiliunas, Cheryl  Applications ™ Help Menu™ Log Off | |.O
Home: | Documents
View + New QOrganize Send More Actions Details e M 4 ofl » M
My Documents Title & Type Last Run Instances
Folders [ |AUDIT REPORTS Folder
I8 o.bic Folders
[ |cLams Falder
[E] |CLIMNICAL REPORTING Falder
E |crm Folder
[E] | FINANCE DEPARTMENT Folder
[E1 | 1L PROVIDER COMMECT Folder
[E | ILLINOIS SERVICE CENTER Folder
[E1 | kANSAS SERVICE CENTER Folder
i [EJ | MBHP SERVICE CENTER Folder
Categories
Search
Total: 9 items
Expand the folders and select IL PROVIDER CONNECT.
\'Jr.--\'“'-l'[_iFSE:[EUN-\'EU Welcome: Masiliunas, Cheryl | Applications*  Help Menu~ Log Off | |p
Home | Documents
View ¥ New = Organize ~ Send More Actions Details = M 4 IZ' of1 » M
My Documents Title ~ Type Last Run Instances
I:Zolders [E1 | Claims Reporting Folder
= .
=1 pubic Folders L7 | HFS Claims Reporting Folder
B [ AUDIT REPORTS [(1 | Registration Reporting Falder
B 50 o avs ﬂ Field Descriptions - IL Claims Data Set | Adobe Acrobat
B [E71 ¢ INICAL REPORTING ﬂ Field Descriptions - IL Claims Detail Daj Adobe Acrobat
E - 'E Field Descriptions - IL Consumer Regis| Adobe Acrobat
B iy 'E Field Descriptions - IL Consumer Regis| Adobe Acrobat
FINAMCE DEPARTMEMT
5 ﬁ IL IntelligenceConnect Report Listing & Adobe Acrobat
% ILPROVIDER CONNECT E ﬂ Provider Guide to InteligenceConnect| Adobe Acrobat
=7 claims Reporting " | warrant Payment Link Reports Overvil Adobe Acrobat
[ HFs Claims Reporting
S| Registration Reporting
B [ 11 1NOTS SERVICE CENTER
B [ kansAS SERVICE CENTER
B [ MBHP SERVICE CENTER
Categories
Search
Total: 10 items
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Click on one of the Reporting folders to display the reports that are available.
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Right-click on the report that you want to run; select the Schedule option from the menu.
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The Schedule box displays with 7 menu options:

e Instance Title

e Recurrence

e Database Logon
Prompts

Filters

Formats
Destinations
Print Settings
Events
Scheduling Server Group
Languages

The only menu options that you will need to access when scheduling your reports are: Instance

Title, Recurrence, Prompts, and Formats.

Schedule - 1L Claims Detail Data Set - HFS

1w Schedue Prompts
it Values...
|
Cearez D Parameter Scheuling Value
Database Logon * Provider o
O * Graimer P
* Servie Code
Filters *DaType
*Sanlate By

- *ExdDae [EMP
Destnaions * Sans Approved
Print Settings

*Required
Events N
Scheduling Server Group

Languages
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Instance Title is the name of the report instance that you are scheduling. You can leave it as the
default name of the report itself, or change it to something different.

| schedule - IL Claims Detail Data Set - HFS =l
Schedule Instance Title
1L Claims Detail Data Set - HFS
Recurrence

Database Logon
Prompts

Filters

Formats

Destinations

Print Settings

Events

Scheduling Server Group

Languages

Recurrence is where you will indicate when you want your report to run. The default value is
“Now” and will run your report one-time, immediately.

sSchedule — IL Claims Detail Data Set - HFS 2 el
Schedule Recurrence
Run object:  [MNow ~

Instance Title
Object will run nowe.

Database Logon

Prompts

Filters

Formats

Destinations

Print Settings

Events

Scheduling Server Group

Languages
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You can select the arrow in the Run Object field to select a recurring time frame to run your
report. It is recommended that you schedule reports to run on a weekly basis, as the data within
these reports is refreshed each week (refreshed data is available each Monday morning).

] Schedule —IL Claims Detail Data Set - HFS

Schedule Recurrence

ject: | Weekly b
Instance Title Fun object Veekly

Object will run every week on the following days.

Database Logan [JMenday ] Friday
Prompte Tuesday  [] Saturday
Filters [] wednesday [] Sunday
Formats [ Thursday
- Start Date/Time:| 04 (% | 39 % |PM | |3/12/2013 i
Destinations — p—
End Date/Time: |03 (% |41 [ ||PM [s|1/28/2023

Print Settings
Events
Scheduling Server Group

Languages

>
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The Prompts menu is where you enter the information for the data you would like returned on
your report.

Schedule - IL Claims Detail Data Set - HFS

1 v schedde Prompts
Instance Tite Edit Values...

Parameter
Database Logon * Provider

* Consumer

* Service Code
Fiers # Date Type
* Start Date

Formats

Destinations

Print Settings

Events

Scheduing Server Group

Languages

| schecke | [ cancel]

You will need to be sure that each parameter is completed within the Prompts section. This

means that the “Scheduling Value” for each of the Parameters should have a value that is not
[EMPTY].
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To enter a Scheduling Value, click on the [EMPTY] link next to the Parameter.

Schedule ~ IL Claims Detail Data Set - HFS 20X
v Schedde Prompts

Instance Tite Edit Values...

Reaurrence Parameter Scheduling Valve

Databsse Logon * povier

* Consumer

* Garvice Code
Fiters “Ds Ty
Formats ke

* End Date

Destinations Er—.

PrintSettings
s Required
Scheduling Server Group

Languages

Enter the information that is needed, and select OK.
Prompts |
Enter prompt values.

Enter Provider Number (= for ALL): Provider
Available Values: Selected Values:

= ] |
Enter a Valus:

Remave || Remave Al |

Complete this step for each parameter. Do NOT select Schedule until all of your parameters
have been entered and there are no longer any [EMPTY] values.
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Prompt/Parameter Types

There are a number of Prompt types that you may need to complete when scheduling a report.

Available Values — For this Prompt type you can:
e Select the asterisk in the Available Values box to bring back all of the data for that field.

e Click on the single arrow in between the Available VValues and Selected Values boxes to
move the asterisk to the Selected Values box.
e Click on OK when you are done.

Prompts

Enter prompt values.

Enter Provider Number (= for ALL): Provider

Selected Values:

Enter a Value:

Remave || Remave Al |

=
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You can also enter values on this type of Prompt. For example, you can enter each Service Code
that you want to display on the report.
e Enter asingle service code in the Enter a Value box.
e Click on the arrow next to that box so that the Service Code displays in the Selected
Values box.
e Repeat this process for each Service Code that you want returned on the report.
e Note: Do not enter the service codes at the same time; enter each one separately, as
detailed above.

Prompts St

Enter prompt values,

Enter Service Code (* for ALL): Service Code
Available Values: Selected Values:

H2015

HOD39

nter a Value:
Hoo39)
Remaove || Remave All |

EmETE
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Pick List Prompt — This type of Prompt has a field available with an arrow to show the available
values.

e Click on the arrow to show the values.

e Select avalue.

e Click on OK.

Promiphs

Enber prompt vasues.

Enber Danbe Type: Dase Tyoe

Aeierned Dabe
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Date Value Prompt — When entering values in this type of Prompt you will need to pay attention
to the date format that is needed.

e Inthe example below, the date needs to be entered in the following format:
YYYYMMDD.

e This means that if you are entering the date of July 1, 2013 you will enter it as: 20130701

Prompts A

Enter prompt values,

Enter Start Date (YYYMMDD): Start Date
20130701
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Once you have completed all of the Prompts, your screen should no longer have any [EMPTY]

Scheduling Values.

Schedule- 1L Claims Detai Data Set - HFS

Schedde Prompts
Istance Tite EditValies..
Rearence Parameter Scheduling Value
Datebase Logon * provid s
* Consumer
* Serviee Code
Fiers DTy
Fomats St Dee
. * End Date
Destinations .
Print Settings
* Requred
Events !
Scheduing Server Group
Languages
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You can now Format your report if needed. All reports have a default output format of either
Excel or PDF, depending on the type of data that is being displayed. Therefore, you can

Schedule your report without accessing the Format menu at this time. However, if you need to
change the format of the report:

e Click on the Format option.

e Select the format for which you would like to see the output of your report.
e Complete the necessary fields.

Schedule - IL Claims Detail Data Set - HFS

v Schedue Formats

Instance Tite
Recurrence
Database Logon
Prompts

Fiters

Destnations

Print Settings

Events

Scheduing Server Group

Languages

Format Options for Selected Document:
Microsoft Excel (97-2003) (Data Only) |v

Crystal Reports

Crystal Reports (RFTR)

Microsoft Excel (97-2003) "eport.
Microsoft Excel Workbook Data-only
Microsoft Word (97-2003)

PDF &
Rich Text Format (RTF)

Microsoft Word - Editable (RTF)

Plain Text

Paginated Text

Tab Separated Text (TTX)

Separated Values (CSV)

36.0

XML

] o T T o ST Y T Y Y T e T v S

Maintain relative object position
Maintain column alignment

Export page header and page footer
[[] simplify page headers

[[] Show group outlines

Once you are done entering all of your settings for the report schedule click on Schedule in the
bottom right-hand corner.
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Your report will appear in the instance History screen with a status of Pending, Running, or
Recurring. To view the updated Status of the report, click on the blue arrows to refresh the
screen.

History — IL Claims Detail Data Set - HFS o=
Instance Time = Title Status Created By Type

,ﬁ Aug 26, 2013 10:11 AM IL Claims Detail Data Set - HFS| Success cmasil Microsoft Excel

,ﬁ Jan 28, 2013 4:.01 PM IL Claims Detail Data Set - HFS Success cmasil Microsoft Excel

,ﬁ Apr 26, 2012 11:09 AM IL Claims Detail Data Set - HFS| Success cmasil Microsoft Excel

,ﬁ Feb 27, 2012 2:16 PM IL Claims Detail Data Set - HFS Success cmasili Microsoft Excel

,ﬁ Dec 15, 2011 2:50 PM IL Claims Detail Data Set - HFS| Success crmasil Microsoft Excel

< >

Total: 5items

Once your report Status updates to Success you can open the report. Click on the Instance Time
to view/open your report. This will bring up the actual report. It may now be printed or saved to
your local PC or shared drive. To print your report click on the ‘Print’ icon, to save your report
click on the ‘Save’ icon and save it on your local drive.

Reports are available on IntelligenceConnect for 7 days.
If you have any questions, or need technical guidance, contact the e-Support Helpdesk at (888)

247-9311, Monday through Friday, 8am — 6pm EST. You may also email the Helpdesk directly
at e-supportservices@valueoptions.com
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